Getting Started

with Military Analyst for ArcGIS® 9.2
## Contents

1 **About Military Analyst** 3
   - What is Military Analyst? 4
   - Military Analyst documentation 6
   - Getting support 7

2 **Installation and startup** 9
   - Installing Military Analyst 10
   - Starting Military Analyst 11

3 **Quick reference** 13
   - The Military Analyst toolbars 14
   - The Military Analyst Options dialog box 15
   - Tools and commands 16
   - Military Analyst in ArcGlobe 20
   - Geoprocessing tools 21
   - More information 22
   - Wireframe symbology 23
About Military Analyst

Welcome to ESRI® ArcGIS® Military Analyst, an extension of ArcGIS consisting of a suite of utilities designed to enhance the geospatial analysis capabilities of the defense/intelligence user community. With Military Analyst (MA), you can easily manage and exploit National Geospatial-Intelligence Agency (NGA) Raster Product Format (RPF) data, Vector Product Format (VPF) data, and Digital Terrain Elevation Data (DTED); perform visibility analysis across DTED tiles; convert coordinates among Universal Transverse Mercator (UTM), Military Grid Reference System (MGRS), and decimal degrees; and measure geodetically accurate distances. Because Military Analyst enables you to perform complex functions within simple, intuitive interfaces with minimal required steps, it is an ideal analysis tool for both novice and advanced users. It is compatible with all levels of ArcGIS (ArcView®, ArcEditor™, and ArcInfo®) and requires that the ArcGIS Spatial Analyst and ArcGIS 3D Analyst™ extensions be installed for complete functionality.

In This Chapter

- What is Military Analyst?
- Military Analyst documentation
- Getting support
Getting Started with Military Analyst

What is Military Analyst?

Military Analyst consists of several geospatial data visualization and analysis tools that are Component Object Model (COM)-compliant and extensible with ArcObjects™. The functionality can be divided into these categories: Data Management, Coordinate tool, Terrain Analysis, Geodesy, Conversion, ArcGlobe™ functionality, and Geoprocessing. These tools are designed to be used separately or together, are fully functional out of the box, and are ideal for customization with ArcObjects.

Data management

Military Analyst makes it easy to manage the display and storage of RPF, DTED, and VPF data by using catalogs to access the data. Creation and data loading of Military Analyst RPF, DTED, and VPF catalogs take place in ArcCatalog™. Military Analyst catalogs provide the ability to load multiple datasets from multiple subfolders in a single process known as recursive data loading, which minimizes the amount of effort required to populate the catalogs with data. The catalogs also allow you to manage how the data is displayed in ArcMap™; this is controlled from the catalog’s Layer Properties dialog box. A key component of each type of catalog is the wireframe, a color-coded footprint showing the geographic extent of the data contained by the catalogs.

RPF and DTED catalogs are customized geodatabase raster catalog objects that can be created in a personal geodatabase (PGDB) or an enterprise geodatabase (Spatial Database Engine™ [SDE®] GDB). As such, they have all the functionality of GDB raster catalogs, along with the additional display behavior and recursive data-loading capabilities provided by Military Analyst. See ‘Building a Geodatabase’ in the ArcGIS Desktop Help for more information on raster catalogs. If the catalog is created in a PGDB, the RPF frame files or DTED cells are referenced from their location on disk (unmanaged). If the catalog is created in an SDE GDB, the RPF frame files or DTED cells that are loaded into the catalog are actually converted to SDE raster datasets and are stored in the underlying relational database management system (RDBMS—managed).

VPF catalogs are custom geodatabase feature classes that reference VPF feature classes on disk. They expand upon the ArcGIS native VPF reading capability by allowing you to select and display as many feature classes as desired from multiple VPF databases and products, rather than having to open one feature class at a time. VPF feature classes are listed on the Layer Properties dialog box with clear and unambiguous names, making it easy for you to select the feature classes that you want to display.

VPF data can be displayed using the default renderer, or the GeoSym renderer. The GeoSym renderer allows you to display GeoSym symbology.

Coordinate tool

The Coordinate tool allows you to quickly and easily convert coordinates between geographic and UTM projections, specifically decimal degrees, degrees/minutes/seconds (DMS), UTM, and MGRS coordinates. It also enables you to find the coordinates for any point in an ArcMap data frame by clicking in the desired location—the Coordinate tool will return the coordinates in the aforementioned formats. In addition, the coordinates on the Coordinate Tool dialog box are continuously updated as you move the pointer around the data frame. What makes the Coordinate tool especially useful is that its application programming interface (API) allows it to be embedded in any ArcGIS application. An example of this is the way the Coordinate tool has been incorporated into the Linear Line of Sight (LLOS) and Radial Line of Sight (RLOS) functions, in which the Coordinate tool can be used to place observer and target points for visibility analysis. The Coordinate tool is also available in ArcGlobe.
The Terrain Analysis tools consist of a collection of surface analysis functions optimized for use with DTED catalogs. With the Terrain Analysis tools, you can quickly and easily mosaic the constituent rasters from RPF and DTED catalogs; determine the location of the highest and lowest elevations in a given area of interest; calculate the linear visibility between two points; compute the radial visibility (viewshed) for a specified observer point based on parameters that allow you to control the heights of the observer and surrounding terrain, as well as the field of view; view and fly through your data in 3D; and create threat domes. The Terrain Analysis tools enable you to perform complex functions with simple interfaces and few required steps, making it an ideal analysis environment for both novice and advanced users. The key feature of the Terrain Analysis tools is that they are all compatible with Military Analyst DTED catalogs, enabling cross-tile surface analysis with no required merging or preprocessing. ArcGIS Spatial Analyst and 3D Analyst are required for complete terrain analysis functionality.

The Geodesy tools provide the capability to calculate and display linear distances and projected ellipses that are spatially accurate and geodetically correct in any projection and in any part of the world. Projections inherently contain distortion; geodesy lines and ellipses account for this distortion. With the Geodesy tools, you can create geodesic lines, great circle lines, and rhumb lines, also known as loxodromes. The tools also include the Range Rings tool, which allows you to place concentric, projected ellipses at a fixed distance around a specified center point.

The Conversion tools’ functionality consists of the Convert Coordinates in File batch coordinate conversion command and the Convert VPF Features function. The Convert Coordinates function allows you to convert all the coordinates in a file, whether contained in a field within a table or the geometry of a feature class. The command supports the same coordinate formats as the Coordinate tool—decimal degrees, DMS, UTM, and MGRS. The Convert VPF Features function allows you to convert VPF data from a VPF catalog to shapefiles, personal geodatabase feature classes, or SDE feature classes. You can convert all the features within selected VPF feature classes or all the VPF features within the visible extent of the ArcMap data frame, or you can select specific features within the VPF feature classes and convert them.

ArcGlobe functionality includes tools for threat dome generation and fly-through capabilities and also includes the Coordinate tool. These tools can be used in ArcGlobe to view and analyze data on a 3D surface. ArcGlobe has its own Military Analyst toolbar that is different from the one displayed in ArcMap.

The Military Analyst Geoprocessing tools provide the ability to convert OILSTOCK data to shapefiles; manage all your military data; and convert table data into different geometries, including ellipses, geodesy lines, lines, polylines, and polygons.

Some of the new features of ArcGIS 9.2 Military Analyst are:

- GeoSym Renderer—The ability to apply GeoSym symbology to VPF data within Military Analyst VPF catalogs is now available.
- Geometry Import geoprocessing tools—The Geometry Import tools allow you to create shapefiles with various feature geometries from input tables of coordinates.
- Data Management geoprocessing tools—The Data Management tools allow you to create and load Military Analyst catalogs.
- Expanded setup—Military Analyst can now be installed on ArcGIS Desktop, ArcGIS Engine, ArcIMS®, or stand-alone ArcReader™.
- Convert coordinates in file - New formats are available for input and output, including TXT and CSV files, point feature classes, and point shapefiles.
Getting Started with Military Analyst

Military Analyst documentation

The Military Analyst documentation set includes:

- This *Getting Started with Military Analyst* guide
- ArcGIS Desktop Help
- Military Analyst context-sensitive help
- ArcGIS Help Online
- ArcGIS Desktop Developer Help
- Military Analyst object model diagram (OMD)

*Getting Started with Military Analyst*—This PDF gives a basic overview of Military Analyst, its toolbars, and all of its tools to assist in startup and act as a quick reference.

*ArcGIS Desktop Help*—The ArcGIS Desktop Help contains complete information about each tool and command and also provides tasks for each one. The ArcGIS Desktop Help is automatically installed when you install any license level of ArcGIS. To access the ArcGIS Desktop Help from ArcMap, ArcCatalog, or ArcGlobe, click Help>ArcGIS Desktop Help or press the F1 key. To access Military Analyst help from there, in the ArcGIS Desktop Help contents, click Extensions>Military Analyst.

*Context-sensitive help*—Military Analyst also includes context-sensitive help, which can be accessed on any dialog box by clicking the Help question mark on that dialog box and clicking a feature on that dialog box with the question mark cursor.

*ArcGIS Help Online*—The help system can be accessed online at [http://webhelp.esri.com](http://webhelp.esri.com). This version of the help is fully searchable and printable.

For developers

*Military Analyst OMD*—This PDF diagram gives a visual overview of the Military Analyst object model. Once Military Analyst is installed, the object model diagram, MilitaryAnalystObjectModel.pdf, can be found in your ArcGIS install location in the Documentation folder.

*ArcGIS Desktop Developer Help*—ArcGIS Desktop Developer Help provides information about creating your own user interfaces, tools, and special applications. This help contains sample code, technical documents, object model diagrams, and the complete object library reference. You can install the ArcGIS Desktop Developer Help from the developer CD in the ArcGIS software installation Media Kit.

Another resource is the ESRI Developer Network (EDN®). EDN provides a comprehensive system for customizing and developing applications with ArcGIS. EDN provides a uniform programming environment and tools that enable developers to:

- Configure and customize ArcGIS applications.
- Embed geographic information system (GIS) and mapping functionality in other applications.
- Build and employ custom ArcGIS Desktop applications.
- Extend the ArcGIS architecture and data model.
- Build Web services and server-based applications.

EDN includes all the developer resources of ArcGIS Desktop, ArcSDE®, ArcIMS, and ArcGIS Server. You can find it at [http://edn.esri.com](http://edn.esri.com).
Getting support

In addition to the Military Analyst documentation set, you can view the knowledge base, a discussion forum, and other documents at ESRI’s support site at http://support.esri.com.

The knowledge base contains technical articles and Military Analyst documentation updated or produced after the release.

The support site also:

- Lets you report problems you have or suggestions for improvement
- Provides downloads for additional applications, utilities, and documentation
- Provides ESRI’s Technical Support phone number
- Provides information about the different types of technical support, including ESRI’s Developer Support Group

You can access the Military Analyst forum on the support site by clicking the User Forums tab.
In This Chapter

• Installing Military Analyst
• Starting Military Analyst

This chapter provides you with the information you need for the quick and easy processes of installing and starting Military Analyst.
Installing Military Analyst

Installation

To install Military Analyst:

Double-click the Setup icon and follow the on-screen instructions.

The system requirements for Military Analyst are:

Any ArcGIS 9.2 application

ArcGIS Spatial Analyst and ArcGIS 3D Analyst (required for use of some Terrain Analysis tools, the 3D Viewer, and the ArcGlobe tools)

60 MB for full install

Windows 2000 or Windows XP

You must uninstall any versions of Military Analyst, including any beta or prerelease versions, prior to installing Military Analyst.

The installation requires system administrator privileges.

Neither MOLE™ nor Grid Manager is installed with Military Analyst.

Table of extension requirements for tools and 3D Viewer

<table>
<thead>
<tr>
<th>Tool</th>
<th>Spatial Analyst required</th>
<th>3D Analyst required</th>
<th>Spatial or 3D Analyst required</th>
<th>MA Catalog functional</th>
<th>Raster dataset functional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mosaic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RLOS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LLOS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hillshade command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Highest point</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lowest point</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extract tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hillshade tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3D Viewer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Accessing documentation

When Military Analyst is installed, the Military Analyst documentation is installed in Program Files\ArcGIS\Documentation. See ‘Military Analyst documentation’ in chapter 1 for a full description of the documentation set.

Other install locations

When Military Analyst is installed, the program’s object library (OLB) files will be in Program Files\ArcGIS\com, or in the ArcGIS\com folder in your specified install location. DLL files will be installed in ArcGIS\bin.
Starting Military Analyst

The Military Analyst functionality will not be available if the extension is not activated. You must enable the Military Analyst extension in ArcCatalog, ArcMap, and ArcGlobe.

1. From the ArcMap main menu, click Tools and click Extensions.
2. On the Extensions dialog box, check the Military Analyst check box.
3. Click Close on the Extensions dialog box.

This activates the Military Analyst extension.

Follow these steps to enable the extension in ArcCatalog and ArcGlobe as well.
Getting Started with Military Analyst

Opening the Military Analyst toolbar

1. From the ArcMap main menu, click View and point to Toolbars.
2. Click Military Analyst in the Toolbars list.

The Military Analyst toolbar will now appear each time you start ArcMap.

Follow these steps to open the Military Analyst toolbar in ArcGlobe as well.
In This Chapter

• The Military Analyst toolbars
• The Military Analyst Options dialog box
• The Military Analyst tools and commands
• The Military Analyst 3D Viewer
• The Military Analyst wireframe symbology

This chapter provides descriptions of the major user interface components, such as toolbars, and descriptions of each of the tools in Military Analyst.
The Military Analyst toolbars

ArcMap toolbar

Drop-down menu
Add MA Layer
Layer select
Terrain Analysis tools
3D Viewer
Coordinate tool

Layer select
Geodesy Graphic tool

Terrain Analysis tools

Add MA Layer

Terrain Analysis tools

Layer select

Commands

Hillshade tool

Highest Point tool

Lowest Point tool

Extract tool

Geodesy Graphic tool

Geodesy tools

Conversion tools

Conversion tools

ArcGlobe toolbar

Drop-down menu
Threat Dome tool

Fly Through tool

Coordinate tool

Military Analyst

Options...
The Military Analyst Options dialog box

The Military Analyst Options dialog box contains all the options not found on a tool’s own dialog box. This Options dialog box contains settings for:

- Units
- Output workspace
- Wireframe
- Uniform rendering
- Terrain analysis
- Symbology
- and Coordinates
**Creating Military Analyst catalogs**

Creation and data loading of Military Analyst RPF, DTED, and VPF catalogs take place in ArcCatalog. Military Analyst catalogs provide the ability to load multiple datasets from multiple subfolders in a single process (also known as recursive data loading), which minimizes the amount of effort required to populate the catalogs with data.

**Loading Military Analyst catalogs**

You can load data into existing Military Analyst RPF, DTED, and VPF catalogs using the Load MA Catalog command in ArcCatalog. Use this to update the data in your catalog without creating a new one.

**Adding Military Analyst layers**

Military Analyst layers are added to ArcMap using the Add MA Layer button on the Military Analyst toolbar. This button filters the available catalogs in a database based on the catalog type. Only catalogs in the database that have the required fields for a DTED, RPF, or VPF catalog are recognized as such.

**Coordinate tool**

The Coordinate tool’s primary interface, the Coordinate Tool dialog box, is a docking window. This allows you to dock the window in ArcMap so it will remain open and active even while you are using another tool. In this way, you can have MGRS coordinates displaying constantly as you move the mouse pointer around the data frame. You can convert coordinates by typing them into the text boxes on the Coordinate Tool dialog box in any of the coordinate systems mentioned in the overview of the Coordinate tool in the ‘What is Military Analyst’ section in chapter 1, then specifying a datum. You can also find and convert the coordinates for a specific point by clicking the desired location in a georeferenced raster or vector file with the Coordinate Tool dialog box open. In addition, the Coordinate tool allows you to find the location of a point with known coordinates.

**Terrain Analysis tools**

The Terrain Analysis tools in Military Analyst are surface analysis operations commonly performed by the defense and intelligence user. In Military Analyst, all the terrain analysis functions can be performed using Military Analyst DTED catalogs as the input surface, which allows cross-tile surface analysis of DTED data.

**Layer list control**

The Layer list control on the Military Analyst toolbar lists all available raster and surface layers in the table of contents (TOC) of the active ArcMap data frame, including Military Analyst RPF and DTED catalogs. The layer that is currently selected will be the input surface layer for the Highest/Lowest Point, Hillshade, and Extract tools, as well as the 3D Viewer.

**Mosaic command**

The Mosaic command can be used to mosaic the constituent raster datasets from Military Analyst RPF and DTED catalogs into single, file-based or SDE raster datasets. The output formats include SDE, personal geodatabase raster, GRID, IMG, and TIFF. The tool is flexible enough to allow you to mosaic a selection of adjacent rasters, all the members of the catalog at once, or rasters in the visible extent of the data frame.
Extract tool

The Extract tool is another mosaicking function of Military Analyst that performs a task similar to the Mosaic command. However, this tool allows you to specify a region by graphic input. The raster data displayed with the catalog in that area can be clipped and mosaicked into a file-based or SDE raster. The Extract tool uses the layer selected in the Layer list control as the input layer.

The Mosaic command and Extract tool only function with Military Analyst RPF and DTED catalogs.

Radial Line of Sight

The RLOS function is an implementation of the Spatial Analyst viewshed function. It calculates a viewshed, an analysis of the visibility of target pixels surrounding an observer point based on their elevation. It allows the interactive creation of observers using the Coordinate tool and the use of DTED catalogs or any ArcGIS software-supported raster surface dataset for performing this analysis.

Linear Line of Sight

The LLOS function requires the input of two points, an observer and a target, as well as their heights above the surface. Military Analyst uses these inputs to calculate what areas of the surface can be seen from the start point along a line extending to the target. The function also allows you to quickly determine if the target is visible to the observer. A color-coded polyline and profile graph are the results of this analysis. The LLOS function uses DTED catalogs or any ArcGIS software-supported raster surface dataset for the input surface.

Hillshade command and tool

The Hillshade function creates a qualitative shading of a surface’s topography based on a hypothetical light source. Creating a hillshade for surface data adds a degree of realism to the experience of viewing the data. It can give the surface an interpretive 3D look during display in ArcMap. Military Analyst provides two methods for generating hillshades. The Hillshade command operates on either raster surface datasets or DTED catalogs.

The Hillshade tool, on the other hand, only operates on DTED catalogs. This tool allows you to specify an area of interest by drawing a bounding rectangle in the data frame, then generates a hillshade for it. This tool is best used for smaller areas of interest.

Highest/Lowest Point tools

The Highest and Lowest Point tools function the same way. Both operate on the surface dataset or DTED catalog currently selected in the Layer list control. The tools analyze the pixels to determine which ones have the highest or lowest value within the box, create a point shapefile, and place a point feature at the location of the highest or lowest point. The elevation of the point is listed with the shapefile in the TOC.
3D Viewer

The Military Analyst 3D Viewer allows you to quickly extract data from an area of interest and display that data in a 3D environment similar to ArcScene™. Inside the Military Analyst 3D Viewer, you will have the ability to navigate around your data, changing the viewing distance and angle. The 3D Viewer will also have the ability to generate threat domes, given the proper inputs. The 3D Viewer replaces Military Analyst functionality in ArcScene. There will no longer be a Military Analyst toolbar in ArcScene.

Geodesy tools

The Geodesy tools provide the capability to calculate and display linear distances and projected ellipses that are spatially accurate and geodetically correct in any projection and any part of the world. Projections inherently contain distortion; geodesy lines and ellipses account for this distortion.

Geodesy Graphic tool

The Geodesy Graphic tool is a quick and easy way to visualize geodesic, great circle, and rhumb lines in ArcMap. The parameters for the lines, including line type, distance units, and azimuth units, are defined on the Military Analyst Options dialog box.

Geodesy Calculator

The Geodesy Calculator offers flexibility when calculating geodesy distances, with options to display and label output geodesic, great circle, and rhumb lines. All the parameters for the calculations, including line type, distance units, and azimuth units, are defined on the Geodesy Calculator dialog box. Input coordinates are interactively specified using the Coordinate tool.
Range Rings tool
The Range Rings tool allows you to quickly visually determine information important for mission planning, such as weapon and aircraft ranges. The output of the Range Rings tool is spatially correct and accurate in any projection. Input center point coordinates are interactively specified using the Coordinate tool.

Conversion tools
The Conversion tools’ group of functionality consists of the Convert Coordinates in File batch coordinate conversion command and the Convert VPF Features function.

Convert Coordinates
The Convert Coordinates function allows you to convert all the coordinates in a file, whether contained in a field within a table or the geometry of a feature class. The command supports the same coordinate formats as the Coordinate tool: decimal degrees, DMS, UTM, and MGRS.

Convert VPF Features
The Convert VPF Features function allows you to convert VPF data from a VPF catalog to shapefiles, personal geodatabase feature classes, or SDE feature classes. You can convert all the features within selected VPF feature classes or all the VPF features within the visible extent of the ArcMap data frame, or you can select specific features within the VPF feature classes and convert them.
Military Analyst in ArcGlobe

Several key Military Analyst tools have now been integrated into the ArcGlobe structure and are available for use, including the Coordinate tool, visibility analysis with the Threat Dome tool, and automatic generation of fly-through animation.

**Fly Through tool**

You can use the Fly Through tool to generate animation in ArcGlobe to fly along a designated flight path or to rotate on a designated point. There are four types of data that can be added for a Military Analyst fly-through in ArcGlobe: a polyline or LLOS feature class, an RLOS observer, a new line, or a new observer point.

**Threat Dome tool**

The Threat Dome tool works the same in ArcGlobe as it does in ArcMap; the only difference is you must add an already-created RLOS observer shapefile to ArcGlobe—it cannot be created there.

You can specify the default output workspace in which the threat dome features generated with the Threat Dome tool are stored by setting this property on the Military Analyst Options dialog box in ArcGlobe.
Geoprocessing tools

Geoprocessing tools allow you to automate many of your GIS tasks by providing an easy-to-use framework for automating workflows. Geoprocessing tools can be executed with a tool’s dialog box through ArcToolbox™, or in the Command Prompt window. See the topic ‘Geoprocessing’ in the ArcGIS Desktop Help for further details. The following topics describe each tool that is specific to Military Analyst.

Import OILSTOCK Overlay tool

Military Analyst includes the Import OILSTOCK Overlay tool, which converts OILSTOCK Overlay files to shapefiles. This tool supports the conversion of OILSTOCK Overlay files containing map coordinates and their symbology to shapefiles and an associated layer file. All basic geometries are converted to their own shapefiles.

Geometry Import tools

The Geometry Import set of tools consists of the Table To Ellipse, Table To Geodesy Line, Table To Line, Table To Polygon, and Table To Polyline tools. These tools convert tables, text and DBF files, and spreadsheets into each respective geometry type in ArcMap, ArcCatalog, or ArcGlobe. Data with the required fields can be easily converted. See the ArcGIS Desktop Help for details about each tool and its required fields.

Data Management tools

The Data Management tools allow you to easily manage all your military data. The Create DTED Catalog, Create RPF Catalog, and Create VPF Catalog tools allow you to create each type of Military Analyst catalog respectively. The Load MA Catalog tool allows you to load data into an already-existing Military Analyst catalog.
More information

For more information on each tool and command and for general tasks related to each one, refer to the ArcGIS Desktop Help, Extensions>Military Analyst. For geoprocessing help, see Geoprocessing tool reference>Military Analyst toolbox.
One of the components of the Military Analyst RPF and DTED catalogs is a wireframe feature layer representing the geographic extents of each of the constituent rasters within the catalog. The wireframe is color coded to differentiate between the various RPF and DTED products contained by the respective catalog; the product represented by each color is explained in the Military Analyst catalog wireframe symbology table.

<table>
<thead>
<tr>
<th>Product</th>
<th>Scale</th>
<th>Color Description</th>
<th>Red</th>
<th>Green</th>
<th>Blue</th>
</tr>
</thead>
<tbody>
<tr>
<td>GNC</td>
<td>1:5,000,000</td>
<td>Mars Red</td>
<td>255</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>JNC</td>
<td>1:2,000,000</td>
<td>Electron Gold</td>
<td>255</td>
<td>170</td>
<td>0</td>
</tr>
<tr>
<td>ONC</td>
<td>1:1,000,000</td>
<td>Solar Yellow</td>
<td>255</td>
<td>255</td>
<td>0</td>
</tr>
<tr>
<td>TPC</td>
<td>1:500,000</td>
<td>Medium Apple</td>
<td>85</td>
<td>255</td>
<td>0</td>
</tr>
<tr>
<td>LFC</td>
<td>1:500,000</td>
<td>Big Sky Blue</td>
<td>0</td>
<td>197</td>
<td>255</td>
</tr>
<tr>
<td>JOG</td>
<td>1:250,000</td>
<td>Cretean Blue</td>
<td>0</td>
<td>112</td>
<td>255</td>
</tr>
<tr>
<td>TFC</td>
<td>1:250,000</td>
<td>Amethyst</td>
<td>197</td>
<td>0</td>
<td>255</td>
</tr>
<tr>
<td>ATC</td>
<td>1:200,000</td>
<td>Olivenite Green</td>
<td>168</td>
<td>168</td>
<td>0</td>
</tr>
<tr>
<td>TLM 100</td>
<td>1:100,000</td>
<td>Tuscan Red</td>
<td>168</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>TLM 50</td>
<td>1:50,000</td>
<td>Malachite Green</td>
<td>0</td>
<td>168</td>
<td>132</td>
</tr>
<tr>
<td>HA</td>
<td>Various</td>
<td>Ultra Blue</td>
<td>0</td>
<td>77</td>
<td>168</td>
</tr>
<tr>
<td>CO</td>
<td>Various</td>
<td>Cattleya Orchid</td>
<td>168</td>
<td>0</td>
<td>132</td>
</tr>
<tr>
<td>OPAREA</td>
<td>Various</td>
<td>Gray 50%</td>
<td>130</td>
<td>130</td>
<td>130</td>
</tr>
<tr>
<td>CG</td>
<td>Various</td>
<td>Fir Green</td>
<td>38</td>
<td>115</td>
<td>0</td>
</tr>
<tr>
<td>Combat Charts</td>
<td>Various</td>
<td>Dark Navy</td>
<td>0</td>
<td>38</td>
<td>115</td>
</tr>
<tr>
<td>Miscellaneous(MM)</td>
<td>Various</td>
<td>Cocoa Brown</td>
<td>137</td>
<td>90</td>
<td>68</td>
</tr>
<tr>
<td>CIB1</td>
<td>1 meter</td>
<td>Light Sienna</td>
<td>205</td>
<td>170</td>
<td>102</td>
</tr>
<tr>
<td>CIB5</td>
<td>5 meter</td>
<td>Medium Olivenite</td>
<td>171</td>
<td>205</td>
<td>102</td>
</tr>
<tr>
<td>CIB10</td>
<td>10 meter</td>
<td>Atlantic Blue</td>
<td>102</td>
<td>153</td>
<td>205</td>
</tr>
<tr>
<td>non-RPF</td>
<td>Various</td>
<td>Gray 70%</td>
<td>78</td>
<td>78</td>
<td>78</td>
</tr>
<tr>
<td>DTED 0</td>
<td>1000 meter</td>
<td>Cantaloupe</td>
<td>255</td>
<td>167</td>
<td>127</td>
</tr>
<tr>
<td>DTED 1</td>
<td>100 meter</td>
<td>Poinsettia Red</td>
<td>230</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>DTED 2</td>
<td>30 meter</td>
<td>Raw Umber</td>
<td>168</td>
<td>112</td>
<td>0</td>
</tr>
<tr>
<td>DTED 3</td>
<td>Unknown</td>
<td>Lime Dust</td>
<td>215</td>
<td>215</td>
<td>158</td>
</tr>
<tr>
<td>DTED 4</td>
<td>Unknown</td>
<td>Macaw Green</td>
<td>152</td>
<td>230</td>
<td>0</td>
</tr>
<tr>
<td>DTED 5</td>
<td>Unknown</td>
<td>Larkspur Blue</td>
<td>68</td>
<td>101</td>
<td>137</td>
</tr>
</tbody>
</table>